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Официальное уведомление

Гарантийные обязательства

Единственные гарантийные обязательства в отношении продуктов и услуг компании НР 
изложены в заявлении о прямых гарантийных обязательствах, которое прилагается к 
таким продуктам и услугам. Никакая часть настоящего документа не должна 
рассматриваться как дополнительные гарантийные обязательства. Компания НР не несет 
ответственности за технические или редакторские ошибки и неточности, содержащиеся в 
данном документе.

Информация, содержащаяся в настоящем документе, может быть изменена без 
уведомления.

Пояснения к ограниченным правам

Конфиденциальное компьютерное программное обеспечение. Для владения, 
использования или копирования необходима действующая лицензия компании HP. В 
соответствии с положениями FAR 12.211 и 12.212 коммерческое программное 
обеспечение для компьютеров, документация программного обеспечения для 
компьютеров и технические данные коммерческих продуктов лицензируются 
государственным учреждениям США на условиях стандартной коммерческой лицензии 
поставщика.

Информация об авторских правах

© Hewlett-Packard Development Company, L.P., 1992-2010.

Информация о товарных знаках

Adobe® является товарным знаком компании Adobe Systems Incorporated.

JavaTM является товарным знаком компании Sun Microsystems, Inc. в США.

Microsoft® и Windows® являются зарегистрированными в США товарными знаками 
корпорации Майкрософт.
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Обновление документации

На титульном листе настоящего документа приведена следующая информация.

• Номер версии программного обеспечения.

• Дата выпуска документа, которая изменяется при каждом обновлении документа.

• Дата выпуска программного обеспечения, т. е. дата выпуска текущей версии 
программного обеспечения.

Чтобы проверить наличие обновлений или убедиться в том, что вы пользуетесь самой 
последней редакцией документа, перейдите на

http://h20230.www2.hp.com/selfsolve/manuals 

Для доступа к этому сайту необходимо зарегистрироваться в службе HP Passport и войти в 
систему. Чтобы зарегистрироваться для получения идентификатора пользователя службы 
HP Passport, перейдите по адресу 

http://h20229.www2.hp.com/passport-registration.html 

Также можно перейти по ссылке New users - please register на странице входа в службу HP 
Passport.

Подписка на поддержку соответствующего продукта также позволяет получать его 
обновленные и новые выпуски. Подробные сведения можно получить у торгового 
представителя компании HP.
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Поддержка

Веб-сайт технической поддержки программного обеспечения компании HP находится по 
адресу

http://www.hp.com/go/hpsoftwaresupport 

На этом веб-сайте приведена контактная информация и подробные сведения о продуктах, 
услугах и поддержке, предоставляемых компанией HP в сфере программного 
обеспечения.

Служба поддержки программного обеспечения компании HP в Интернете предоставляет 
заказчикам возможности для самостоятельного устранения неполадок,  Эта служба 
предоставляет быстрый и эффективный доступ к интерактивным средствам технической 
поддержки, необходимым для управления бизнесом. Клиенты службы технической 
поддержки могут использовать этот веб-сайт для решения следующих задач.

• Поиск необходимых документов в базе знаний.

• Подача и отслеживание заявок в службу технической поддержки и запросов на 
расширение функциональных возможностей.

• Загрузка исправлений программного обеспечения.

• Управление договорами поддержки.

• Поиск контактной информации службы поддержки компании HP.

• Просмотр сведений о доступных услугах.

• Участие в обсуждениях с другими покупателями программного обеспечения.

• Поиск курсов обучения по программному обеспечению и регистрация для участия в 
них.

Для получения доступа к большинству разделов поддержки сначала необходимо 
зарегистрироваться в качестве пользователя службы НР Passport, а затем войти в 
систему. Для ряда разделов поддержки также необходимо наличие договора на оказание 
поддержки..  Чтобы зарегистрироваться на получение идентификатора пользователя 
службы НР Passport, перейдите на страницу:

http://h20229.www2.hp.com/passport-registration.html 

Получить более подробные сведения об уровнях доступа можно по адресу:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Новые возможности

Документ "Новые возможности" включает следующее:

➤ "Новые возможности HP ALM" на стр. 9

➤ "Новые возможности HP ALM Performance Center" на стр. 35
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Новые возможности  HP ALM

В документе "Новые возможности" приводится обзор функций, которые 
были добавлены или усовершенствованы в HP Application Lifecycle 
Management (ALM) 11.00. Дополнительные сведения о HP ALM см. в 
документе Руководство пользователя HP Application Lifecycle Management.

Также представлены демонстрационные видео по возможностям продукта 
HP Application Lifecycle Management, для доступа к ним выберите пункт 
Справка > Ролики по продуктам. 

Документ "Новые возможности HP ALM" включает следующие 
разделы:
➤ HP Application Lifecycle Management 11.00 на стр. 10

➤ Установка на стр. 12

➤ Оптимизированные репозитории проектов на стр. 13

➤ Одновременный запуск клиентов ALM на стр. 14

➤ Релизы планирования и отслеживания проектов (PPT) на стр. 14

➤ Интеграция модели бизнес-процесса на стр. 15

➤ Таблица прослеживаемости на стр. 16

➤ Конфигурации тестов на стр. 16

➤ Новая ручная среда выполнения — HP Sprinter на стр. 16

➤ Отчеты о проекте на стр. 17

➤ Обновления интерфейса пользователя на стр. 18

➤ Улучшения администрирования на стр. 22

➤ Изменения в поддержке функций на стр. 26

➤ Обновления API-интерфейсов и баз данных на стр. 27

➤ Business Process Testing на стр. 29

➤ Библиотека документации на стр. 32
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HP Application Lifecycle Management 11.00
HP Application Lifecycle Management (ALM) позволяет ИТ-специалистам 
управлять основным жизненным циклом приложений — от требований до 
развертывания, предоставляя группам разработчиков приложений 
возможности визуализации и совместной работы, необходимые для 
создания современных приложений в условиях предсказуемости, 
воспроизводимости и гибкости.

ALM предоставляет рекомендации на всех этапах управления жизненным 
циклом приложения. За счет интеграции задач управления приложениями 
это решение позволяет обеспечить более полное соответствие ИТ-
решений потребностям бизнеса. Дополнительные сведения см. в 
документе Руководство пользователя HP Application Lifecycle 
Management.

Кроме того, ALM включает возможности Performance Center, которые 
обеспечивают управление всеми аспектами крупномасштабных проектов 
по тестированию, включая выделение и планирование ресурсов из 
центральной консоли, доступной через Интернет. См. дополнительные 
сведения о возможностях Performance Center в "Новые возможности 
HP ALM Performance Center" на стр. 35.

Решение ALM также включает функциональные возможности Application 
Governance. Этот компонент представляет собой платформу для 
обеспечения соответствия внутренним правилам во время проектирования 
для инфраструктуры услуг. См. дополнительные сведения в документации 
HP ALM Application Governance.
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HP ALM Выпуски
ПО HP Application Lifecycle Management (ALM) доступно в трех выпусках, 
предоставляющих различные наборы функций ALM — HP Quality Center 
Starter Edition, HP Quality Center Enterprise Edition и HP ALM 
Performance Center Edition.

Дополнительные сведения см. в документе Руководство пользователя 
HP Application Lifecycle Management.

HP ALM Edition Описание

HP ALM Полный набор функций HP ALM, предоставляющий 
ключевые средства управления жизненным циклом и 
масштабируемого управления качеством для крупных 
организаций и передовых технических центров, 
участвующих в управлении корпоративными 
релизами. 

HP Quality Center 
Starter Edition

Для групп управления качеством, работающих с 
малыми релизами.

HP Quality Center 
Enterprise Edition

Для групп управления качеством, работающих со 
средними и крупными релизами.

HP ALM Performance 
Center Edition

Для управления всеми аспектами крупномасштабных 
проектов по тестированию.
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Установка
Процесс установки и обновления был изменен следующим образом. 
Дополнительные сведения см. в документе Руководство по установке 
HP Application Lifecycle Management.

Поддерживаемые среды
Сведения о рекомендуемых и поддерживаемых конфигурациях сервера 
ALM доступны в ALMReadme-файле HP  Application Lifecycle Management 
11.00. 

Внимание! Данные о поддерживаемых средах в Readme-файле 
HP Application Lifecycle Management 11.00 точны для версии ALM 11.00, но 
для исправлений ALM 11.00 возможно обновление этих данных. 
Актуальные сведения о поддерживаемых средах доступны на сайте 
программного обеспечения HP по следующему адресу: 
http://www.hp.com/go/TDQC_SysReq

Приложение ALM интегрировано с другими средствами тестирования 
компании HP. Чтобы проверить, используется ли поддерживаемая версия, 
на странице надстроек нажмите ссылку Дополнительные надстройки HP 
HP Application Lifecycle Management. Выберите таблицу интеграции 
ALM 11.00 

Мастер установки
➤ В процесс установки добавлены контрольные проверки.

➤ Теперь мастер установки включает два этапа: копирование файлов и 
настройка сервера. Это значит, что конфигурацию сервера можно 
изменить без переустановки приложения.

http://www.hp.com/go/TDQC_SysReq
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Защита данных
ALM шифрует информацию для доступа к внешним системам (базы 
данных, Windows и LDAP) и защищает обмен данными с другими 
приложениями HP BTO.

Клиент ALM
Установка клиента ALM больше не требует привилегий администратора на 
компьютере. Привилегии администратора все еще потребуются для 
установки некоторых надстроек.

Оптимизированные репозитории проектов
Теперь файлы проектов сохраняются в оптимизированной системе 
репозиториев, которые обеспечивают повышенную производительность 
распространенных действий и увеличивают емкость системы.

Файлы в репозитории проекта сохраняются в оптимизированной структуре 
папок, которая обеспечивает эффективное использование хранилища. 
Кроме того, дубликаты файлов будут храниться в репозитории в одном 
экземпляре. Это обеспечит существенное сокращение занимаемого места 
на диске. Например, если приложить файл к нескольким записям ALM, он 
будет сохранен в репозитории проекта только один раз.

Дополнительные сведения см. в документе Руководство администратора 
HP Application Lifecycle Management.

При обновлении с версий Quality Center 9.2 или 10.00 ALM переносит 
файлы из старого репозитория проектов в оптимизированный репозиторий. 
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Одновременный запуск клиентов ALM
На одной рабочей станции можно использовать несколько версий 
HP Application Lifecycle Management (ALM) одновременно. Сюда входит 
несколько клиентов ALM 11.00, подключающихся к различным серверам 
ALM Platform, и один клиент Quality Center 10.00 или 9.2.

Дополнительные сведения см. в документе Руководство по установке 
HP Application Lifecycle Management.

Релизы планирования и отслеживания проектов (PPT)
Функция планирования и отслеживания проектов обеспечивает 
отслеживание готовности приложений путем настройки вех для операций, 
связанных с релизом приложений, в модуле Релизы. PPT использует 
ключевые индикаторы производительности для анализа данных, связанных 
с указанными вехами. Общая работоспособность и готовность релиза к 
развертыванию отображается в виде карты оценки. Карта оценки 
ежедневно отслеживает выполнение каждой вехи. Для дальнейшего 
анализа результатов можно создать отчеты и графики панелей 
мониторинга.

Дополнительные сведения см. в документе Руководство пользователя 
HP Application Lifecycle Management.

Функция PPT недоступна в HP Quality Center Starter Edition, 
HP Quality Center Enterprise Edition и HP ALM Performance Center Edition.
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Интеграция модели бизнес-процесса
Теперь приложение поддерживает импорт моделей бизнес-процессов, 
созданных во внешних средствах разработки моделей. При импорте 
моделей бизнес-процессов в новый модуль Бизнес-модели автоматически 
создается структура требований, представляющих каждую модель и 
операцию. Затем можно создать покрытие тестами и оценить качество 
моделей бизнес-процессов.

Кроме того, в модели можно добавить объекты пути, представляющие 
полную последовательность действий и обеспечивающие тестирование 
бизнес-потоков.

Дополнительные сведения см. в документе Руководство пользователя 
HP Application Lifecycle Management и Передовые методы работы с 
модулем бизнес-моделей HP ALM.

Модуль бизнес-моделей недоступен в HP Quality Center Starter Edition и HP 
ALM Performance Center Edition.
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Таблица прослеживаемости
Теперь можно указывать уровень отношений между требованиями, а также 
между требованиями и тестами с помощью представления Таблица 
прослеживаемости в модуле Требования. Таблица прослеживаемости 
помогает проверить выполнение всех требований и выявить изменения 
рамок требований, когда они возникают. Дополнительные сведения см. в 
документе Руководство пользователя HP Application Lifecycle 
Management.

Конфигурации тестов
Вкладка Конфигурации тестов в модуле План тестирования позволяет 
разрабатывать тесты, которые выполняются в различных сценариях 
использования с различными наборами данных. Каждый сценарий 
использования называется конфигурацией теста. Значения конфигураций 
тестов получаются из проекта ALM или внешнего источника данных. 
Дополнительные сведения см. в документе Руководство пользователя 
HP Application Lifecycle Management.

Новая ручная среда выполнения — HP Sprinter
Теперь ручные тесты в ALM можно выполнять в модуле "Тестовая 
лаборатория" с помощью нового приложения HP Sprinter. Sprinter 
предлагает расширенные возможности и различные инструменты, 
облегчающие процесс ручного тестирования, включая следующее: 

➤ создание и аннотирование скриншотов;

➤ запись роликов выполнения;

➤ запись и выполнение макросов в тестируемом приложении;

➤ автоматический ввод данных в поля приложения;

➤ автоматическое добавление списка шагов или действий пользователя в 
регистрируемые дефекты;

➤ репликация действий пользователя на нескольких компьютерах с 
разными конфигурациями.
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См. дополнительные сведения в документе Руководство пользователя 
HP Sprinter на странице надстроек HP Application Lifecycle Management 
(выберите Справка > Страница надстроек).

Функции Sprinter недоступны в HP Quality Center Starter Edition и HP ALM 
Performance Center Edition.

Отчеты о проекте
Новое средство отчетности Отчеты о проекте доступно в модуле 
Представление анализа и обеспечивает разработку и создание 
всесторонних отчетов с данными по проектам. Используя шаблоны, 
разработанные администратором проекта для каждого объекта ALM, 
пользователи создают отчеты по проектам путем выбора объектов, 
входящих в разделы отчетов, и настройки фильтров данных.

Отчеты по проектам предлагают следующие преимущества:

➤ Полноценное форматирование и верстка с помощью шаблонов MS Word.

➤ Повышенная производительность.

➤ Единая конфигурация для нескольких форматов вывода (doc, docx, html).

➤ Централизованное управление шаблонами.

Дополнительные сведения см. в документе Руководство пользователя 
HP Application Lifecycle Management.
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Обновления интерфейса пользователя
В данном разделе описываются улучшения удобства работы с 
HP Application Lifecycle Management 11.00. Дополнительные сведения см. в 
документе Руководство пользователя HP Application Lifecycle Management.

Навигация по модулям
Новая боковая панель навигации по модулям обеспечивает быстрый 
доступ к модулям, доступным в ALM.  

Избранные представления
Теперь можно использовать вложенные папки для упорядочения 
избранных представлений. Например, можно создать папки для 
организации избранных представлений по продукту, версии релиза или 
группе. 

Улучшения библиотеки
В модуле "Библиотеки" добавлены следующие улучшения:

➤ Улучшен процесс создания библиотеки. Он включает следующие 
улучшения:

➤ Фильтрация библиотек. Раньше при создании библиотеки в нее 
добавлялись все записи в выбранных папках. В ALM 11.00 при 
создании библиотеки также можно настроить фильтр для каждого 
добавляемого дерева объектов. Это улучшает контроль над 
содержимым библиотеки.

➤ Автоматическое включение связанных объектов при создании 
базового состояния. Раньше при создании библиотеки, включающей 
тесты, пользователь должен был выбрать все связанные объекты, 
необходимые для выполнения тестов, например вызванные тесты и 
ресурсы тестов. В ALM 11.00 связанные объекты автоматически 
добавляются при создании базового состояния библиотеки.

➤ Добавление тестов в библиотеку в соответствии с покрытием. 
При выборе тестов для добавления в библиотеку можно 
автоматически включить тесты, которые покрывают требования в 
библиотеке.
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➤ Экспорт базового состояния и результатов сравнения библиотек. 
Теперь базовое состояние и результаты сравнения библиотек можно 
сохранить в формате СSV. 

Функции модуля "Библиотеки" недоступны в HP Quality Center Starter 
Edition.

Улучшения требований
В модуле "Требования" добавлены следующие улучшения:

➤ Упорядочение требований. Раньше требования добавлялись в дерево 
требований в порядке создания. Для изменения порядка нужно было 
сортировать дерево по выбранным полям. В ALM 11.00 можно 
перемещать требования в дереве для создания любого логического 
порядка. 

➤ Редактор RTF. Средства работы с форматом RTF улучшены в 
ALM 11.00. Новая версия включает следующие улучшения:

➤ переход с редактора на основе Microsoft Word на HTML-редактор; 

➤ расширение просматриваемой области;

➤ улучшение производительности при открытии и сохранении текста в 
формате RTF;

➤ наличие поля для поиска;

➤ поддержка шаблона RTF.

Улучшения выполнения тестов
В модуле "Тестовая лаборатория" добавлены следующие улучшения:

➤ Теперь модуль "Тестовая лаборатория" включает две основные вкладки:

➤ На вкладке Наборы тестов отображается представление дерева 
наборов тестов.

➤ На вкладке Выполнения тестов отображаются все выполнения 
проектов в виде таблицы.

Представление таблицы наборов тестов больше не доступно.
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➤ Управление выполнениями. Теперь пользователь может 
просматривать и фильтровать все выполнения в проекте в едином 
представлении таблицы. Эта функция доступна на новой вкладке 
Выполнения тестов в модуле "Тестовая лаборатория". 

➤ Черновые выполнения. Теперь тест можно настроить в качестве 
чернового выполнения, чтобы приложение ALM пропустило результаты 
выполнения. Это позволяет попробовать тесты, находящиеся на этапе 
разработки, или только что измененные тесты без влияния на такие 
статистические показатели, как статус теста или покрытия. 

➤ Поле "Состояние выполнения". Новое поле Состояние выполнения 
обеспечивает отслеживание статуса текущего выполнения. 

➤ Статус выполнения "Заблокировано". К выполнениям тестов 
добавлен новый статус. Статус Заблокировано означает, что 
выполнение теста невозможно. Это позволяет отличить тесты, которые 
не были выполнены, например, из-за недостатка времени, и тесты, 
которые не выполнены по другим причинам, таким как проблемы сети 
или отказ оборудования. 

➤ Сводка выполнения. Теперь можно настроить ALM для отправки сводки 
результатов тестов указанным пользователям по электронной почте 
после выполнения набора тестов. Этот параметр доступен на вкладке 
"Автоматизация". 

➤ Диалоговое окно "Свойства экземпляра теста" переименовано в 
"Сведения об экземпляре теста".

Улучшения панели мониторинга.
В модуле "Панель мониторинга" добавлены следующие улучшения:

➤ Теперь модуль "Панель мониторинга" может включат два дочерних 
модуля:

➤ Модуль Представление анализа содержит элементы анализа, 
которые ранее отображались на вкладке "Представление анализа".

➤ Модуль Представление панели мониторинга содержит элементы 
анализа, которые ранее отображались на вкладке "Представление 
панели мониторинга".



Новые возможности

21

21

➤ Графики. Для графиков представлены следующие улучшения:

➤ Совместное использование графиков. Теперь графики можно 
предоставлять для просмотра в браузере без загрузки клиента ALM. 

➤ Параметры конфигурации. В графиках хода выполнения и 
тенденции пользователь имеет полных контроль над периодом 
графика.  

Диспетчер задач
Теперь можно просматривать ход выполнения и статус асинхронных задач 
в проекте. Новое диалоговое окно "Диспетчер задач" обеспечивает 
просмотр задач, выполняемых в фоновом режиме, таких как создание 
базового состояния и импорт библиотеки. 

Восстановление подключения к сеансу
Если сеанс ALM остается неактивным в течение определенного периода 
времени, он отключается. Раньше пользователь должен был выйти из 
системы и войти в нее повторно, что подразумевало повторную загрузку 
настройки проекта.

Теперь при отключении сеанса система предлагает восстановить 
подключение. Если администратор проекта не внес существенных 
изменений в настройку проекта, она не загружается повторно, что 
позволяет быстро восстановить подключение и продолжить работу с 
момента отключения.
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Улучшения администрирования
В данном разделе описываются усовершенствования функций 
администрирования в HP Application Lifecycle Management 11.00. 
Дополнительные сведения см. в документе Руководство администратора 
HP Application Lifecycle Management.

Импорт пользователей LDAP
Раньше для импорта пользователей LDAP использовался просмотр и 
фильтрация дерева LDAP. В ALM 11.00 допускается поиск пользователей 
LDAP по ключевым словам. 

Активация расширений проектов
Теперь можно активировать расширения проекта при его создании. Раньше 
расширение проекта можно было активировать только после его создания. 

Межпроектная настройка
При применении настройки шаблона настройка доступа к модулям в 
шаблоне применяется к связанным проектам. 

Межпроектная настройка недоступна в HP Quality Center Starter Edition и 
HP Quality Center Enterprise Edition.
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Деактивация пользователей
Теперь пользователей можно деактивировать в Site Administration. 
Деактивированный пользователь не может войти в проекты ALM. Это 
позволяет временно запретить доступ пользователя к проекту, но 
сохранить его данные, параметры и разрешения. 

Обновление типов тестов
После регистрации настраиваемых типов тестов в ALM необходимо 
синхронизировать изменения активных проектов в Site Administration. 

QC Sense
Теперь пользователь может проанализировать данные об использовании и 
производительности ALM с помощью приложения QC Sense, нового 
внутреннего средства мониторинга. QC Sense собирает данные о 
действиях пользователей, выполненных в интерфейсе ALM, и отслеживает 
все операции клиентов и серверов, вызванные этими действиями. На 
основе данных QC Sense можно создавать отчеты, обеспечивающие 
анализ и сравнение показателей производительности. 

Конфигурация сайта 
На вкладке Конфигурация сайта были добавлены следующие параметры:

➤ DEBUG_CLOSURE_LOG_DOM_PROJ

➤ DISABLE_PASSWORD_OTA_ENCRYPTION

➤ ENTITY_LINK_HOST

➤ ENTITY_LINK_PORT

➤ EVENT_LOG_PURGE_PERIOD_DAYS

➤ EXTENDED_MEMO_FIELDS

➤ FAST_RECONNECT_MODE

➤ LIBRARY FUSE

➤ REQUIREMENTS LIBRARY FUSE

➤ REST_API_DEFAULT_PAGE_SIZE
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➤ REST_API_MAX_PAGE_SIZE

➤ REST_SESSION_MAX_IDLE_TIME

➤ SSO_EXPIRATION_TIME

➤ SUPPORT_TESTSET_END

Были удалены следующие параметры:

➤ ALLOW_REQ_COVERAGE_BY_TEST_INSTANCE

➤ LIBRARY_BROKEN_LINKS_VERIFICATION_FUSE

События рабочего процесса
Процедуры событий рабочего процесса были добавлены в следующие 
модули:

Модуль События

Релизы ➤ ReleaseFolder_AfterPost

Бизнес-модели ➤ CanReImportModels
➤ Набор событий (таких как _MoveTo, 

_FieldChange) для объектов BusinessModel, 
BusinessModel_Activity, BusinessModelPath и 
BusinessModelFolder.

Бизнес-компоненты ➤ CanAddComponentstoTest
➤ CanRemoveComponentsFromTest
➤ CanAddFlowsToTest
➤ CanRemoveFlowsFromTest
➤ CanDeleteGroupsFromTest
➤ Component_CanDelete и 

ComponentFolder_CanDelete. (Отдельный 
синтаксис событий CanDelete доступен для 
компонентов и папок компонентов.)

➤ Набор событий (таких как _New, _FieldChange) 
для объекта ComponentFolder.
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Другие улучшения: 

➤ Событие GetDetailsPageName поддерживается для всех объектов, не 
только для объектов дефектов.

➤ Определенные события больше не поддерживаются для новых проектов, 
но поддерживаются в обновленных проектах для обратной 
совместимости (например, MoveToSubject и GetNewReqPageName). 

Дополнительные сведения см. в документе Руководство администратора 
HP Application Lifecycle Management

План тестирования ➤ Test_CanDelete и TestFolder_CanDelete. 
(Отдельный синтаксис событий CanDelete 
доступен для тестов и папок тестов.) 

➤ Набор событий (таких как _New, _FieldChange) 
для объектов TestFolder и TestConfiguration.

Тестовая лаборатория ➤ RunTests_Sprinter
➤ TestSet_CanDelete и TestSetFolder_CanDelete. 

(Отдельный синтаксис событий CanDelete 
доступен для наборов тестов и папок наборов 
тестов.) 

➤ Набор событий (таких как _New, _FieldChange) 
для объекта TestSetFolder.

Модуль События
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Изменения в поддержке функций
В приложении HP Application Lifecycle Management 11.00 больше не 
поддерживаются следующие функции:

Прекращение поддержки WinRunner
Тесты WinRunner больше нельзя создавать в ALM 11.00. Однако при 
обновлении предыдущих версий Quality Center выполнение существующих 
тестов WinRunner допускается. 

Настройка дефектов: видимые поля в диалоговом окне 
добавления дефектов
Поле Видимые поля в диалоговом окне добавления дефектов 
настройки групп больше недоступно в ALM 11.00. Чтобы определить 
видимые поля дефекта, воспользуйтесь диалоговым окном "Выберите 
поле" на вкладке "Скрытие данных" страницы "Группы и разрешения" 
модуля "Настройка". Кроме того, можно создать сценарий рабочего 
процесса. 

Печать дефектов
В модуле "Дефекты" больше нельзя печатать данные о дефектах 
непосредственно из таблицы дефектов. Вместо этого следует 
экспортировать данные о дефектах или создавать соответствующие 
графики и отчеты.

Проверка поврежденных связей библиотеки
Проверка поврежденных связей библиотеки больше не входит в процесс 
создания базового состояния в ALM 11.00. Теперь процесс создания 
базового состояния автоматически включает все связанные объекты, 
необходимые для выполнения тестов в библиотеке. Дополнительные 
сведения см. в разделе "Улучшения библиотеки" на стр. 18.

Фиксированные столбцы в таблице дефектов.
Возможность создания столбцов без возможности прокрутки в таблице 
дефектов больше не доступна.
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Добавление обязательных столбцов в таблицу
При добавлении теста в набор тестов, создании или обновлении дефекта 
автоматическое добавление обязательных полей в таблицу больше не 
доступна. Вместо этого следует воспользоваться параметром "Выберите 
столбцы" для добавления необходимых полей.

Назначение существующих наборов разрешений группам 
пользователей
При создании новой группы пользователей можно назначить привилегии 
предыдущей группы пользователей, если эти привилегии соответствуют 
тем, которые нужно назначить новой группе. Возможность сброса 
разрешений группы пользователей к разрешениям другой группы больше 
не доступна. 

Добавление пользователей в проекты из предыдущей версии
В ALM 11.00 нельзя добавлять пользователей в проект из предыдущей 
версии, пока этот проект не будет обновлен.

Обновления API-интерфейсов и баз данных
В данном разделе описаны обновления API-интерфейсов. 

➤ ALM 11.00 может использовать клиентское развертывание, которое 
позволяет клиенту подключаться к нескольким экземплярам ALM 
Platform. Это влияет на API-интерфейсы следующим образом:

➤ Автоматическая регистрация библиотеки типов OTA на клиентском 
компьютере больше не выполняется. Перед подключением к 
ALM Platform с помощью приложения OTA следует 
зарегистрировать библиотеку на сервере, запустив приложение HP 
ALM Client Registration со страницы надстроек ALM. См. 
дополнительные сведения в разделе Регистрация ALM на рабочей 
станции в Руководстве по установке HP ALM.

➤ Процесс установки настраиваемых типов тестов изменен. См. 
Руководство по настраиваемым типам тестов HP ALM.

➤ В новой версии доступны ресурсы REST для ALM. См. дополнительные 
сведения в Справочнике по API-интерфейсу HP ALM на основе REST.
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➤ Содержимое справочника HP Quality Center Entity Dependencies API 
Reference, опубликованное с версией Quality Center, было добавлено в 
Справочное руководство по API-интерфейсу открытой архитектуры 
тестирования HP. Справочник по зависимостям не предоставляется как 
отдельный раздел справки ALM.

➤ Следующие свойства объекта OTA CustomizationPermissions имеют 
атрибут "только чтение":

➤ CanAdditem

➤ CanAllowAttachment

➤ CanModifyField

➤ CanModifyItem

➤ CanRemoveItem

➤ CanUseOwnerSensible

➤ Следующие методы объекта OTA CustomizationAction устарели:

➤ AddGroup

➤ RemoveGroup

➤ Теперь объект OTA TreeMananager отвечает только за дерево субъектов 
тестирования. Для списков проектов следует использовать 
Customization.Lists.

➤ Теперь поля RTF сохраняются как поля memo, а не как DOC-файлы.

➤ Метод CreateProjectCopy API-интерфейса Site Administration больше не 
поддерживает параметр SA_PROJECT_CREATION_FORCE_IF_ACTIVE. 
Проект должен быть деактивирован перед копированием.

➤ Таблица HISTORY больше не существует. События регистрируются в 
таблицах AUDIT_LOG и AUDIT_PROPERTIES. Соответствующие 
изменения внесены в OTA.

➤ Новые элементы в справочниках по API-интерфейсу отмечены красной 
меткой в содержании. Метка присутствует на уровнях объекта и таблицы. 
Отдельные поля, методы и свойства не отмечаются.
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Business Process Testing 

Новые возможности HP Application Lifecycle Management 11.00 также 
поддерживаются для объектов Business Process Testing. Кроме того, в 
приложении Business Process Testing были добавлены или 
усовершенствованы следующие функции ALM 11.00. 

Дополнительные сведения об этих функциях см. в Руководстве 
пользователя HP Business Process Testing.

Повышение производительности при выполнении 
автоматизированных компонентов QuickTest
Для повышения производительности тесты бизнес-процессов или потоки, 
которые содержат только автоматизированные компоненты QuickTest, 
компилируются как тесты QuickTest с помощью механизмов, которые 
называются тестами оболочки BPT. Тесты и потоки автоматически 
упаковываются, когда QC выполняет тест без действий пользователя. См. 
дополнительные сведения о выполнении тестов с помощью механизма 
тестов оболочки BPT в документе Руководство пользователя HP Business 
Process Testing. 

Доступность
Компонент Business Process Testing доступен в Quality Center Starter Edition 
и Quality Center Enterprise Edition. Дополнительные сведения см. в 
документе Руководство пользователя HP Application Lifecycle 
Management. 

Улучшенный пользовательский интерфейс
В интерфейсе Business Process Testing добавлены следующие улучшения:

➤ Общий вид тестов бизнес-процессов в модуле "План тестирования" 
переработан. Например, плоский список компонентов заменен на 
древовидное представление, которое позволяет сворачивать и 
разворачивать группы компонентов в дереве.
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➤ Диалоговое окно "Итерации" предоставляет дополнительные 
возможности, такие как поиск значений, переключение между 
представлением с одной и несколькими итерациями и др.

Улучшения среды приложения
Теперь среды приложений представляют собой стандартные ресурсы 
тестов, доступные из модуля "Ресурсы тестирования" ALM. Таким образом, 
пользователи могут легко идентифицировать компоненты, связанный с 
каждой средой приложений, и содержимое каждой среды приложения 
(такое как репозитории объектов и библиотеки функций). 

Улучшения: 

➤ Теперь среды приложений могут создаваться в модуле "Ресурсы 
тестирования" ALM без необходимости в запуске средства тестирования 
QuickTest Professional. Дополнительные сведения см. в документе 
Руководство пользователя HP Business Process Testing.

➤ Теперь можно просматривать зависимости компонентов от сред 
приложений.

➤ Среды приложений включаются в библиотеки и базовые состояния и 
могут сравниваться и импортироваться.

➤ Среды приложений (кроме шаблона среды приложения 
BusinessComponentTemplate10), не связанные с компонентом, могут 
удаляться из ALM без необходимости в запуске средства тестирования 
QuickTest Professional. 

Конфигурации тестов, обращающиеся к статическим и 
динамическим данным
Business Process Testing поддерживает конфигурации тестов, 
обращающиеся к статическим и динамическим данным. 

➤ Конфигурации тестов ALM обращаются к статическим данным на уровне 
конфигурации. Конфигурации тестов бизнес-процессов позволяют 
указывать разные значения данных для каждой итерации. 
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➤ Пользователь может создать конфигурации тестов бизнес-процессов, 
обращающиеся к динамическим данным. Динамические данные 
позволяют запускать экземпляры тестов, используя конфигурации 
тестов, основанные на внешнем файле ресурсов данных, например 
Microsoft Excel. 

Детализация покрытия требований расширена, поскольку требование 
может быть покрыто тестом бизнес-процесса и несколькими 
конфигурациями этого теста (сценариями использования). Каждая 
конфигурация тестирует отдельный набор данных в том же сценарии 
тестирования.

Дополнительные сведения см. в документе Руководство пользователя 
HP Business Process Testing.

Критерии
При создании покрытия между требованиями и тестами бизнес-процессов 
можно настроить покрытие по критериям теста, таким как бизнес-
компонент или поток, вместо покрытия каждого требования только на 
уровне теста. 

Эта функция увеличивает детализацию покрытия требований, обеспечивая 
распространение более точных результатов в модуле "Требования" ALM. 
Пользователь может выбрать нужные компоненты и потоки из перспективы 
покрытия. Только эти компоненты и потоки будут влиять на расчеты 
покрытия требований.

См. дополнительные сведения о критериях тестов в разделе Руководство 
пользователя HP Business Process Testing. 

Дополнительные функции новой ручной среды 
выполнения — HP Sprinter
В дополнение к функциям, перечисленным выше в разделе "Новая ручная 
среда выполнения — HP Sprinter" на стр. 16, для Business Process Testing 
доступны следующие расширенные возможности: 

➤ просмотр параметров в шагах;

➤ потоки могут разворачиваться и сворачиваться как любой другой объект 
в иерархии тестов;



Новые возможности

32

32

➤ боковая панель "Шаги" поддерживает переход к предыдущему и 
следующему компонентам.

См. дополнительные сведения в документе Руководство пользователя 
HP ALM Sprinter на странице надстроек HP Application Lifecycle Management 
(выберите Справка > Страница надстроек).

Изменения в поддержке функций
➤ Представление таблицы в модуле "Бизнес-компоненты" удалено.

➤ Типы параметров удалены. Теперь все параметры имеют тип "строка".

Библиотека документации
В библиотеку документации HP ALM добавлены следующие изменения.

Новый внешний вид
Организация документов изменена для ускорения доступа, описания 
функций разделены на категории:

➤ Разделы категории Концепции содержат общие сведения, описания и 
концептуальную информацию о функции.

➤ Разделы категории Задачи содержат пошаговые руководства, которые 
помогают решить те или иные задачи с помощью приложения.

➤ Разделы категории Справка содержат справочные сведения, 
относящиеся к определенной функции. Сюда входят общие сведения об 
элементах интерфейса, таких как окна, диалоговые окна и мастера.
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Новая документация
В документацию внесены следующие дополнения:

➤ Теперь библиотека документации HP ALM включает документацию 
Performance Center. Обратите внимание, что предыдущий документ HP 
Performance Center Monitor Reference включен в новый документ 
Руководство HP ALM Performance Center. Это руководство включает 
документацию для пользователей и администраторов.

➤ Передовые методы включают два новых руководства: 

➤ Передовые методы обновления HP ALM содержит методы 
планирования обновления ALM и подготовки к нему.

➤ Передовые методы работы с модулем "Бизнес-модели" HP ALM 
содержит передовые методы работы с модулем "Бизнес-модели". 

➤ Справочники по API-интерфейсам включают новый интерактивный 
Справочник по API-интерфейсу HP ALM на основе REST HP ALM. API-
интерфейс REST можно использовать для доступа к данным ALM и 
работы с ними.

Документы, выведенные из эксплуатации

Следующие документы выведены из эксплуатации:

➤ Руководство по подготовке к обновлению HP Quality Center: 
Содержимое этого документа включено в Руководство 
администратора HP ALM в разделе "Устранение проблем подготовки к 
обновлению".

➤ HP Quality Center Entity Dependencies API Reference: Содержимое этого 
файла справки доступно в Справочнике по открытой архитектуре 
тестирования HP ALM.

➤ Учебное руководство HP Business Process Testing: См. ролики по 
продуктам для Business Process Testing.
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Новые возможности HP ALM 
Performance Center

В этой главе представлен обзор возможностей, добавленных или 
усовершенствованных в HP ALM Performance Center 11.00. 
Дополнительные сведения о HP ALM Performance Center см. в документе 
Руководство HP ALM Performance Center.

Также представлены демонстрационные видео по возможностям продукта 
HP ALM Performance Center, для доступа к ним выберите пункт Help > 
Product Feature Movies. 

Документ "Новые возможности HP ALM Performance Center" включает 
в себя следующие разделы:

➤ Администрирование и управление лабораторией на стр. 36

➤ Возможности администрирования пользователей на стр. 38

➤ Отдельные приложения на стр. 43

➤ Сопоставление функций на стр. 45
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Администрирование и управление лабораторией
Добавлены следующие улучшения администрирования:

Улучшенное управление проектами
Теперь проекты создаются и администрируются на платформе ALM. 
Основные преимущества:

➤ Поддержка группирования проектов в домены в соответствии с 
различными критериями. Например, подразделение, приложение.

➤ Гибкая настройка проектов, включающая добавление полей и свойств к 
существующим объектам.

➤ Шаблоны проектов обеспечивают настройку и обслуживание общего 
набора настроек проектов для нескольких проектов.

➤ Импорт и экспорт для удобного архивирования проектов.

Дни виртуальных пользователей (VUD)
ALM Performance Center 11.00 предоставляет новую модель 
лицензирования по мере использования, которая помогает поставщикам 
услуг и делает возможным разовые операции тестирования. VUD 
лицензируются на ежедневной основе и могут использоваться для любого 
протокола. 

Как только лицензия для VUD активирована, ее можно использовать в 
течение 24 часов для нескольких тестов производительности и любого 
протокола. По прошествии 24 часов срок действия VUD истекает и VUD 
вычитается из лицензии. 

VUD представляет собой более гибкую модель лицензирования и может 
использоваться, когда потребуются временные лицензии для 
дополнительных виртуальных пользователей. Кроме того, VUD можно 
использовать, если постоянная лицензия для того или иного протокола 
отсутствует.
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Улучшенное управление хостами
Гибкость назначения хостов проектам и их использования в тестах 
производительности увеличена (старое название: тесты нагрузки). 

Объединенные пулы удалены, теперь любой хост может быть назначен 
нескольким пулам. Это улучшение упрощает совместное использование 
хостов проектами. Кроме того, хосты можно привязать напрямую к пулу 
хостов из самого пула. 

Другое важное улучшение — функция свойств хоста. При использовании 
настройки проекта список доступных свойств (например, расположение, 
мощность ЦП, объем памяти, установка ПО и др.) можно настраивать и 
выбирать для каждого хоста. Эти свойства можно использовать при 
разработке тестов производительности и резервировании таймслотов для 
сужения набора хостов автоматического сопоставления (старое название: 
виртуальные хосты) и поиска соответствующего совпадения.

Улучшенные проверки состояния системы
Новые возможности "Check Host" и "Check Server" обеспечивают 
отслеживание и обслуживание статуса системы. Эти периодические 
проверки выполняются автоматически и обеспечивают постоянный 
мониторинг основных компонентов системы. Кроме того, добавлено 
несколько автоматизированных задач для поиска и устранения 
возникающих ошибок.

Полное резервирование 
ALM Performance Center основывается на решении ALM Platform, которое 
поддерживает несколько узлов. Также допускается добавление нескольких 
серверов Performance Center с внутренними механизмами распределения 
нагрузки. 
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Возможности администрирования пользователей
Добавлены следующие улучшения администрирования пользователей:

Прослеживаемость требований к дефектам
Теперь пользователи могут управлять требованиями к производительности 
и отслеживать их статус с точки зрения дефектов. Дефект можно напрямую 
связать с требованием или тестом производительности, который покрывает 
его.

Рекомендуется следующий рабочий процесс:

 1 Составление требования к производительности.

 2 Покрытие требования тестом производительности.

 3 Составление соответствующего соглашения об уровне обслуживания.

 4 Связывание дефектов с выполнениями тестов.

Резервирование таймслотов
Пользовательский интерфейс резервирования таймслотов стал более 
информативным и удобным и включает следующие улучшения:

➤ Представление календаря включает следующие улучшения:

➤ Одновременное отображение нескольких резервирований.

➤ Отображение полной информации о резервировании таймслотов, 
включая выделенные хосты, из вашего проекта или любого другого 
проекта, доступного вам.

➤ Отображение двойных часовых поясов.

➤ Возможность выбирать ежедневное или еженедельное 
представление.

➤ Быстрое отображение пользовательских резервирований.
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➤ Резервирование новых таймслотов включает следующие улучшения:

➤ Возможность указывать имя таймслота.

➤ Мастер резервирования явно сообщает, когда запрошенные ресурсы 
доступны.

➤ Резервирование сочетания определенных хостов и хостов 
автоматического сопоставления (старое название: реальные и 
виртуальные хосты) в том же таймслоте.

➤ Хосты автоматического сопоставления можно настроить с помощью 
свойств хостов, которые предоставляют более точные характеристики 
хоста.

➤ Представлен новый тип таймслота: тайм-слот обслуживания. Он 
планируется администратором Performance Center в модуле 
управления лабораторией и используется при выделении хостов для 
задач обслуживания, таких как установка исправлений.

➤ Обработка ошибок включает следующие улучшения:

➤ Полная и подробная информация при проблемах выделения.

➤ При сбое таймслота отправляются уведомления по электронной 
почте.

➤ Изменения тестов производительности автоматически 
распространяются на таймслот, связанный с тестом 
производительности.

➤ Доступно представление таблицы с расширенными возможностями 
фильтрации и сортировки.

Управление тестируемыми приложениями (AUT)
Эта функция обеспечивает управление набором хостов тестируемых 
приложений (AUT). Хосты AUT могут объединяться в пулы хостов AUT, 
аналогичные хостам и пулам хостов Performance Center.

Хосты AUT являются ключевым элементом интеграции топологии и 
SiteScope. Таким образом, их можно добавлять не только в модуле 
управления лабораторией, но и в самом проекте ALM.
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Интеграция топологии и SiteScope
ALM Теперь Performance Center может формулировать топологию 
тестируемых приложений (представление развертывания) и использовать 
ее в качестве интерфейса для настройки мониторов производительности с 
помощью интеграции с HP SiteScope. 

Дополнительные возможности:

➤ Все участники проекта могут визуально анализировать тестируемые 
среды.

➤ Шаблоны мониторов упрощают их настройку.

➤ Проблемы производительности среды выполнения выявляются путем 
выделения статуса узла топологии в соответствии с порогами монитора 
SiteScope.

➤ Новая и улучшенная интеграция SiteScope:

➤ Интерфейс пользователя SiteScope размещается в ALM 
Performance Center, что обеспечивает применение возможностей 
SiteScope способами, ориентированными на сценарии 
использования, без дополнительной настройки монитора в 
Performance Center.

➤ Возможность принимать или отклонять выполнение мониторов за 
пределами контекста теста производительности. Это улучшает 
масштабируемость сервера SiteScope и уменьшает сетевой шум, 
когда тесты не выполняются.

➤ Данные SiteScope отображаются в различных графиках на экранах 
выполнения Performance Center. При этом имена изменений можно 
легко определить и отфильтровать.
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Расширенное управление активами тестов 
производительности
Управление активами тестирования производительности (тестами, 
сценариями и мониторами) улучшено и поддерживает следующие новые 
возможности:

➤ Управление активами в иерархическом представлении папок.

➤ Управление циклами выполнения тестов.

➤ Копирование всех активов тестирования в рамках проектов и между 
ними.

➤ Использование управления версиями для отслеживания изменений.

➤ Управление активами в библиотеках, которые могут совместно 
использоваться проектами.

➤ Теперь пользователи получают доступ к расширенному управлению 
зависимостями между активами тестирования, такими как тесты 
производительности и сценарии.

Улучшения разработки тестов производительности
ALM Performance Center повышает удобство и функциональность 
инструментов, используемых на этапе разработки тестов 
производительности. Добавлены следующие возможности:

➤ Выбор узла контроллера для теста.

➤ Улучшенное сводное представление теста.

➤ Назначение свойств хостов (например, установленных на клиенте Citrix) 
для назначения соответствующих хостов при выполнении.

➤ Назначение узлов автоматического сопоставления (виртуальных) и 
определенных (реальных) хостов в одном тесте.

➤ Добавление метки к группе для ускоренной разработки и изменения 
тестов.

➤ Одновременное назначение сценариев тесту.

➤ Параметры среды выполнения: Управление дополнительными 
атрибутами в ALM Performance Center.
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➤ Интеграция средств диагностики J2EE/.NET (только HP Diagnostics 9.0): 
Фильтрация зондов по полю статуса работоспособности.

➤ Соглашения об уровне обслуживания:

➤ Добавлен новый тип соглашения об уровне обслуживания Transaction 
Percentile.

➤ Возможность установки десятичных значений в качестве порогов.

➤ Количество транзакций, которые могут измеряться соглашениями об 
уровне обслуживания, больше не ограничено.

➤ Добавлен новый отчет, в котором отображается статус соглашения об 
уровне обслуживания.

Запуск выполнения
В процесс запуска выполнения внесены следующие усовершенствования:

➤ Теперь процесс охватывает больше этапов инициализации тестов, таких 
как выделение хостов. 

➤ Тесты производительности стали быстрее.

➤ Тесты производительности можно отменить на этапе инициализации при 
возникновении критических ошибок.

My Performance Center
My Performance Center — это дополнительное представление с 
интерфейсом, разработанным специально для выполнения тестов. Оно 
позволяет создавать индивидуальные представления функций 
тестирования производительности, упрощая выполнение повседневных 
операций тестирования производительности.



Новые возможности

43

43

Отдельные приложения
Добавлены следующие улучшения отдельных приложений:

VuGen и протоколы
Добавлены новые протоколы и функции, существующие функции 
усовершенствованы:

➤ Ajax TruClient. Новый усовершенствованный протокол для приложений 
на основе JavaScript, включая Ajax. Новый протокол эмулирует действия 
пользователя в браузере. Сценарии разрабатываются интерактивно с 
помощью Mozilla Firefox. 

➤ Silverlight. Новый протокол для приложений на основе Silverlight, 
эмулирующий действия пользователей на транспортном уровне. Этот 
протокол обеспечивает создание общих сценариев путем 
автоматического импорта и настройки WSDL-файлов, используемых 
приложением.

➤ Java over HTTP. Новый протокол, разработанный для записи 
приложений и апплетов на основе Java. Этот протокол позволяет создать 
сценарий Java с помощью веб-функций и отличается от других 
протоколов Java возможностью записи и воспроизведения удаленных 
вызовов Java с помощью HTTP-вызовов.

➤ Data Format Extension (DFE). Новая возможность, улучшающая 
форматирование данных для семейства веб-протоколов (HTTP/HTML). 
Эта возможность обеспечивает преобразование HTTP-трафика в 
обслуживаемый структурируемый формат XML и корреляцию через 
XPATH.

➤ Correlation Studio. Этот механизм автоматической корреляции веб-
трафика (HTTP/HTML) улучшен для поиска корреляций в большем 
диапазоне данных снимков, созданных при формировании кода, включая 
данные, отформатированные DFE.

➤ Snapshot View. Новое представление снимков для этапов веб-протокола 
(HTTP/HTML) обеспечивает просмотр всего HTTP-трафика в 
необработанном формате и формате DFE.

Дополнительные сведения см. в документе Руководство пользователя 
HP Virtual User.
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Analysis
В приложение HP Analysis внесены следующие улучшения.

Дополнительные сведения см. в документе Руководство пользователя HP 
LoadRunner Analysis.

Категория Улучшение

Средства отчетности ➤ Полностью настраиваемые шаблоны отчетов, 
обеспечивающие управление содержимым и 
форматом отчетов. 

➤ Экспорт отчетов в различные форматы, такие 
как Word, Excel, PDF и HTML.

➤ Шаблон сеанса Analysis позволяет связать 
несколько шаблонов отчетов с различными 
периодами.

➤ Автоматическое создание отчетов при 
создании данных Analysis из отдельного 
экземпляра HP Analysis.

Соглашение об уровне 
обслуживания

➤ Добавлен тип соглашения об уровне 
обслуживания Transaction Percentile.

➤ Настройка десятичных значений порогов.

Удобство использования ➤ Фильтрация условных обозначений и данных 
графика, а также необработанных данных по 
любому столбцу с помощью подстановочных 
знаков и операторов "подобно".

➤ Фильтрация графика перед открытием.
Примечание. Это уменьшит требования 
процесса Analysis к памяти в крупных сеансах.

➤ Теперь в HTML-отчете отображаются полные 
имени измерений.

➤ Улучшения интерфейса для управления 
шаблонами сеансов Analysis.
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Сопоставление функций
В следующей таблице представлены данные сопоставления, которые 
позволяют найти функции HP Performance Center 9.5x в 
HP ALM Performance Center 11.00.

Этот раздел содержит следующие подразделы.

➤ "Performance Center Сопоставление функций администрирования сайта 
9.5x" ниже

➤ "Performance Center Сопоставление функций управления 
пользователями сайта 9.5x" на стр. 50

Performance Center Сопоставление функций 
администрирования сайта 9.5x
В следующей таблице представлено расположение функций 
администрирования сайта Performance Center 9.5x в модуле управления 
лабораторией ALM Performance Center 11.00. См. сведения о входе в 
модуль управления лабораторией в документе Руководство 
HP ALM Performance Center.

Функция
Модуль 
Performance 
Center 9.5x

Модуль управления лабораторией 
ALM Performance Center 11.00 

Хосты Ресурсы На боковой панели модуля 
управления лабораторией в разделе 
Lab Resources выберите Hosts.

Средства 
отслеживания MI

Ресурсы На боковой панели модуля 
управления лабораторией в разделе 
Lab Resources выберите 
MI Listeners.

Расположение 
хостов

Ресурсы На боковой панели модуля 
управления лабораторией в разделе 
Lab Resources выберите Locations.

Пулы хостов Ресурсы На боковой панели модуля 
управления лабораторией в разделе 
Lab Resources выберите Host Pools.
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Серверы Ресурсы На боковой панели модуля 
управления лабораторией в разделе 
Lab Resources выберите 
PC Servers.

Выполнения 
тестов

Управление 
сайтом

На боковой панели модуля 
управления лабораторией в разделе 
Lab Resources выберите Test Runs.

Таймслоты Управление 
сайтом

На боковой панели модуля 
управления лабораторией в разделе 
Lab Resources выберите Timeslots.

Autostart Viewer Управление 
сайтом

➤ Прошлые тесты 
производительности 
автозапуска. На боковой панели 
модуля управления лабораторией 
в разделе Lab Usage выберите 
Test Runs.

➤ Будущие тесты 
производительности 
автозапуска. На боковой панели 
модуля управления лабораторией 
в разделе Lab Usage выберите 
Timeslots. Будущие тесты можно 
определить по дате начала.

Функция
Модуль 
Performance 
Center 9.5x

Модуль управления лабораторией 
ALM Performance Center 11.00 
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Журнал событий Управление 
сайтом

➤ На боковой панели модуля 
управления лабораторией в 
разделе Lab Resources выберите 
Hosts.

➤ На боковой панели модуля 
управления лабораторией в 
разделе Lab Usage выберите Test 
Runs.

➤ На боковой панели модуля 
управления лабораторией в 
разделе Lab Resources выберите 
PC Servers.

➤ На общей панели инструментов 
выберите Tools > Event Log.

Лицензия Конфигурация 
системы

На боковой панели модуля 
управления лабораторией в разделе 
Lab Settings выберите License.

Общие 
параметры

Конфигурация 
системы

На общей панели инструментов 
управления лабораторией выберите 
Tools > Performance Center General 
Settings.

Диагностика Конфигурация 
системы

На боковой панели модуля 
управления лабораторией в разделе 
Lab Settings выберите Diagnostics.

Конфигурация 
сервера

Конфигурация 
системы

На боковой панели модуля 
управления лабораторией в 
разделеLab Settings выберите PC 
Servers.

Аутентификация 
сервера

Конфигурация 
системы

Аутентификация серверов 
выполняется с помощью функции 
управления пользователями ALM.

Функция
Модуль 
Performance 
Center 9.5x

Модуль управления лабораторией 
ALM Performance Center 11.00 
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Настройка 
уведомлений

Конфигурация 
системы

Отслеживание выполняется с 
помощью внутреннего механизма 
периодической проверки, который 
заменяет SiteScope.

Отчеты Отчеты На боковой панели модуля 
управления лабораторией в разделе 
Lab Usage выберите Usage Reports.

Примечания.

➤ Доступно два новых отчета:
➤ VUDs License Project Usage 

Report
➤ VUDs License Site Usage 

Report
➤ Отчет Site Users Report больше 

не доступен.

Личные сведения Управление 
пользователями

В проекте ALM выберите Tools > 
Customize > User Properties. 

Дополнительные сведения о HP ALM 
см. в документе Руководство 
пользователя HP Application Lifecycle 
Management.

Пользователи Управление 
пользователями

В проекте ALM выберите Tools > 
Customize > Project Users.

Дополнительные сведения о HP ALM 
см. в документе Руководство 
пользователя HP Application Lifecycle 
Management.

Функция
Модуль 
Performance 
Center 9.5x

Модуль управления лабораторией 
ALM Performance Center 11.00 
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Управление 
ролями и 
привилегиями

Управление 
пользователями

В проекте ALM выберите 
Инструменты > Настроить > 
Группы и разрешения.

Дополнительные сведения о HP ALM 
см. в документе Руководство 
пользователя HP Application Lifecycle 
Management.

Проекты Управление 
пользователями

➤ Добавить проект: проекты 
создаются Site Administration. См. 
сведения о доступе к Site 
Administration в документе 
Руководство администратора 
HP Application Lifecycle 
Management.

➤ Сведения о проекте: для 
настройки параметров проекта на 
боковой панели управления 
лабораторией в разделе 
Lab Settings 
выберитеProject Settings.

Функция
Модуль 
Performance 
Center 9.5x

Модуль управления лабораторией 
ALM Performance Center 11.00 



Новые возможности

50

50

Performance Center Сопоставление функций управления 
пользователями сайта 9.5x
В следующей таблице представлено расположение функций управления 
пользователями сайта Performance Center 9.5x в модуле управления 
лабораторией ALM Performance Center 11.00. Дополнительные сведения о 
HP ALM см. в документе Руководство пользователя HP Application Lifecycle 
Management.

Функция
Модуль 
Performance Center 
9.5x

ALM Performance Center 11.00

Status > General Проект Доступно только в перспективах 
Performance. См. 
дополнительные сведения о 
перспективах Performance в 
документе Руководство 
HP ALM Performance Center. My 
Performance Center.

Status > Dashboard Проект На боковой панели ALM в разделе 
Requirements выберите 
Requirements. Затем выберите 
View > Coverage Analysis.

Примечание. Это не точное 
воспроизведение панели 
мониторинга Performance Center. 
В ALM Performance Center 11.00:

➤ Статус уровня транзакций 
можно посмотреть только в 
отчете по соглашению об 
уровне обслуживания.

➤ Необходимо составить 
требования, чтобы посмотреть 
полные сведения о статусе.

Хосты Проект На боковой панели ALM в разделе 
Lab Resources выберите Hosts.
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Таймслоты Проект На боковой панели ALM в разделе 
Lab Resources выберите 
Timeslots.

Топологии На боковой панели ALM в разделе 
Lab Resources выберите 
Topologies.

Примечание. Топологии — это 
новая возможность.

Сценарии Vuser Проект На боковой панели ALM в разделе 
Testing выберите Test Plan

Примечание. Таблица базовой 
информации обо всех сценариях 
в проекте недоступна. Для 
просмотра информации об 
отдельных сценариях выберите 
Script Folder > <нужный 
сценарий>. Информация будет 
отображаться в верхнем правом 
углу

Профили 
мониторов

Проект На боковой панели ALM в разделе 
Testing выберите Test 
Resources.

Autostart Viewer Проект ➤ Прошлые тесты 
производительности 
автозапуска. На боковой 
панели ALM в разделе Testing 
выберите Test Lab

➤ Будущие тесты 
производительности 
автозапуска. На боковой 
панели ALM в разделе Lab 
Resources выберите 
Timeslots. Тесты можно 
определить по дате начала.

Функция
Модуль 
Performance Center 
9.5x

ALM Performance Center 11.00
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Параметры Проект На боковой панели ALM в разделе 
Tools, выберите PC Project 
Settings. 

Изменить проект Проект На боковой панели ALM в разделе 
Tools выберите Change Project

Управление Тесты нагрузки На боковой панели ALM в разделе 
Testing выберите Test Plan

Выполнения тестов Тесты нагрузки На боковой панели ALM в разделе 
Testing выберите Test Lab. Затем 
перейдите на вкладку Test Runs.

Отчеты по 
тенденциям

Тесты нагрузки На боковой панели ALM в разделе 
Testing выберите Test Lab. Затем 
перейдите на вкладку Test Runs и 
нажмите кнопку Performance 
Trending . 

Личные сведения Управление 
пользователями

На общей панели инструментов 
выберите Tools > Customize > 
User Properties.

Пользователи Управление 
пользователями

На общей панели инструментов 
выберите Tools > Customize > 
Project Users

Роли Управление 
пользователями

На общей панели инструментов 
выберите Tools > Customize > 
Groups and Permissions.

Проекты Недоступно ALM 
Performance Center 11.00.

Управление 
привилегиями

Управление 
пользователями

На общей панели инструментов 
выберите Tools > Customize > 
Project Users

Функция
Модуль 
Performance Center 
9.5x

ALM Performance Center 11.00
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Загружаемые 
файлы

Разное На общей панели инструментов 
выберите Tools > Download 
Standalone Applications

Новые возможности Разное На общей панели инструментов 
выберите Help > What’s New

Функция
Модуль 
Performance Center 
9.5x

ALM Performance Center 11.00
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